4.4.1 ARTICULATE. [17]

Articulate is a rapid eLearning program with an intuitive technology to train and communicate widely, rapidly and effectively for academic costumers, you can make easy to create a professional Flash presentation, add narration and interactivity in a PowerPoint file and transform it to a Flash presentation easily.

Develop and deliver content fast and distribute it in a Flash format that can be viewed for anyone. You can do it in three simple steps.

- Step 1: Create your PowerPoint presentation.

Include animations if desired; type your script directly into the presenter field in association with each slide.

- Step 2: Add your narration.

Select record narration in the Articulate menu and begin recording, you can record also with animations and later review the audio recorded. You can look at your slide notes at the same time that you are recording them; this can help you to find the best words for your narration.

- Step 3: Publish for online delivery.

Select publish in the Articulate menu and add the presentation that you want to publish on the Web by adding the publish location and presentation title. By selecting the player template from the drop-down menu, you also have the possibility to edit the desired player templates and to select the presenter/s and logo options.

4.4.1.1 How to use Articulate?

When you have successfully installed Articulate in your computer, you can access to the Articulate menu display and see the different options you can work with.
4.4.1.2 Narration and audio

You can add narration to your slides with the Record Narration Window.

Select Record Narration from the Articulate Menu and the Record Narration window will be displayed in the lower right-hand corner of the screen.
In the Record Narration Window you have different options of recording, click on the Record button to start recording, and use Pause to take breaks during the recording. When you have finished, click Stop and to continue click again on the same button.

To move forward to the next slide click Next and to finish click Close.

If the slides contain animations, you will be taken to the Next Animation once you have finished recording by clicking again on the Record button. Automatic animations will respect the timings set within the Custom Animation dialog of PowerPoint.

Using Options you can record only one slide, show slides notes or display the total duration of the presentation below the slide counter.
4.4.1.3 Import Audio

In addition to recording your own narration, you can also add narration to your presentation by importing audio files. This may be necessary when you want to add audio that was previously recorded.

Select Import Audio from the Articulate Menu and the Import Audio window will be displayed.

To import audio, select the audio file that you want to import by browsing; you can only import one audio file per slide; so you have to repeat this for all the slides you want to import audio and click Done when you have finished. You can also remove the narrations or imported files that you desire.
4.4.1.4 Sync Animation Timings

If you wish to edit the timings of your animations, you can do it either with the Timeline Audio Editor or with the Edit Animation Timings Window. This is useful if you are satisfied with the audio, but you would like to make adjustments to the timeline when the animations are being displayed.

Select Sync Animation Timings from the Articulate Menu and the Sync Animation Timing window will be displayed.
Click *Start Sync* to play the audio and *Next Animation* to see the next animation. Repeat this for all animations on that slide and use *Options* to see the slide notes or the total audio duration.

4.4.1.5 **Timeline Audio Editor**

You have precise control over your recorded or imported narration, allowing you to edit the audio track for each slide, as well as drag-and-drop markers for synchronizing your narration with your animation. You can also import, cut, paste, and delete narration.

Select *Timeline Audio Editor* from the Articulate Menu.
Details about the audio on each slide are shown at the bottom of the Timeline Audio Editor and you can use its different options to listen, synchronize and review the narrations or imported audio files of your presentation. With this option you can also create new narrations, import audio files or icons, and remove them if you desire.
You can also edit the volume, increase or decrease it with the volume controller, fit the balance of your records and have a view of your recordings by using the zoom.

Another possibility to adjust balance and volume is the *Recording Source & Volume* with which you can record a new narration.

4.4.1.6 Library and options

Articulate includes an option to set up presenters, logos, playlist and quality among other settings.

Select *Library and Options* from the Articulate Menu
4.4.1.6.1 Logos

Select the logos option to add, delete your logos or to create a new default logo.
4.4.1.6.2 Presenters

Select the *presenters* option to add, delete or edit a default presenter to the presenters library. Edit the name, email, biography and photo of the presenter and the title of the presentation.

You can add a new presenter when you publish a presentation or to assign a different presenter to each slide of your presentation using the *Slide Properties Manager*.

4.4.1.6.3 Playlists

You can create a new playlist, rename, delete, add, remove, move the tracks up/down; put it on the top/bottom. If the playlist duration is less than the duration of the slides you can also loop the playlist.

Regule the Volume level related to narration from the selected playlist to any audio. You can also add records to the playlist using *Record Narration* or to import it by using the *Import Audio* option.
4.4.1.6.4 Quality

You can optimize the quality of presentations that will be delivered on a web server via internet or intranet, optimize for CD-ROM delivery or customize for users with an advanced knowledge on compression settings.
4.4.1.6.5 Other

Set the **Timing** for slides that contain animations, **SWF options** to configure Flash options and **General** for other specific options.
4.4.1.7 Slide Properties Manager

Select *Slide Properties Manager* from the Articulate Menu

The presentation or eLearning course title appears in the upper left-hand corner of the *Slide Properties Manager*; this title is taken from your file name. The total number of slides and the total duration of your presentation or eLearning course are displayed in the upper right-hand corner.

Details on other elements of the *Slide Properties Manager* are outlined below:

- **Type**: The icon in the Type column represents the type of content of the slides.
- **PowerPoint Slide Title**: This is the title of your PowerPoint slide.
- **Display in navigation**: This is the title of the slide you would like to appear in the Articulate Player Navigation.
- **Level**: The hierarchical or nested level of the slide relative to others.
- **Change view to**: Use this field to automatically change the view of your presentation or eLearning course on a per-slide basis.
- **Presenter**: This is the presenter you would like to associate with the selected slide.
- **Audio Playlist**: This is the playlist you would like to associate with the selected slide.
- **Move to next slide**: Use this setting to determine whether the slides should advance automatically to the next one during the presentation, or whether the user will need to click Next to advance.
- **Group by**: Select how to sort the Slide Properties Manager.
You can group the slides by slide number, type, presenter, change view to, audio playlist or move to the next slide.
4.4.1.8 Quizzes and Learning Games

Note: To create a new quiz you need to have installed Articulate Quizmaker.

You can incorporate your quizzes created with Articulate Quizmaker directly into the Articulate Presenter. To create a new quiz you have to install Articulate Quizmaker in your computer.

Select Quizzes and Learning Games from the Articulate Menu

To insert your .AQP file into the Articulate Presenter, select Insert published Quizmaker Quiz.
Browse to locate an .AQP file and the quiz will be added when you publish your presentation.

If the user passes the quiz you can choose different ways to continue such as closing the window, moving to a URL or to a specific slide.
Specify if it is obligatory that the user completes the quiz to continue or if it is possible to view the slides at any time, after attempting the quiz or after passing the quiz.

To edit your Articulate Quizmaker Quiz select Edit settings for inserted Quizmaker quiz; for which previously you should have included a quiz.
• To add a Learning Game.

Select Quizzes and Learning Games from the Articulate Menu

A learning game can be used for knowledge checks and make your presentation engaging and interactive. You can add a new learning game or edit an existing learning game slide.

With articulate presenter we can create three types of games:

• **Choices**: Multiple choice and True/False questions.
• **Word quiz**: The user objective is to reveal the hidden answer before running out of time.
• **Sequence**: The user objective is to arrange items in the correct sequence before running out of time.

![Learning Games Wizard](image)

You also have the possibility to display the standard instructions of the learning game and to display a customized message before the learning game.
Enter the questions and answers for the different games and the type of interaction that you select for them.

You can also modify the feedback text that will appear when the user will finish the game.
Finally, click finish to insert the Learning Game into the presentation. You can copy and paste your learning Game slide into any other eLearning course or presentation.

4.4.1.9 Engage Interactions

Note: To use this option you have to be installed Articulate Engage

You can add your interactions created with Articulate Engage directly into Articulate Presenter.

Select Articulate Engage Interactions from the Articulate Menu.
• **Interactions Slides:**

Your interaction will be inserted as an entire slide within your eLearning course or presentation. Use this option if you want to make your interaction, such as a process or timeline.

• **Interaction Tabs:**

Your interaction will be inserted into a specified slide as drop-down reference content within the slide so users can reference the interactive content at any point within the course. This is perfect for interactive FAQs and glossaries that you want to be accessible throughout the eLearning course or presentation.

4.4.1.10 To add a Flash Movie

Select *Insert Flash Movie* from the Articulate Menu and the Flash Movie wizard will be displayed.
The Flash Movie Wizard will appear to insert a Flash movie; you can display the Flash Movies in three different modes:

- **Display in slide**: This will display your Flash movie (.SWF format) in the slide panel.

- **Display in presenter panel**: This will display your Flash movie (.SWF or .FLV format) in the presenter panel of your presentation.

- **Display in new browser window**: This will open a new window independently from your slide within your Flash movie (.SWF format).
In this window you have to enter the location (path) to your Flash movie.

4.4.1.10.1 Configuring Flash Movie to display in Slide

Select the appropriate Synchronization for your Flash movie.

- **Play Flash movie and slide in sync:**

Select this item for Flash movies that have defined beginning and end points such as videos, screen recordings and many simulations. This item will automatically set the slide length to match the length of the Flash movie. You will also be able to play/pause and seek within the Flash movie using the Articulate Player controls.

Choose whether the slide will automatically advance to the next slide when the movie finishes, or if the user must click the next button to move on. Set a buffer duration (in seconds) before the movie begins to play.
• **Play Flash movie after slide has begun:**

Select this item for highly interactive Flash movies that do not have a clearly defined end point such as interactive “click and explore” movies.

Choose when the Flash movie will start being displayed on the screen. By default, the movie will display immediately but you can change these settings with *The Articulate Player controls*.

You can also choose whether the slide will automatically advance to the next slide when the movie finishes, or if the user must click on the *next* button.
4.4.1.10.2 Configuring Flash Movie to display in presenter panel

Choose whether the slide will automatically advance to the next slide when the movie finishes, or if the user must click on the next button.
4.4.1.10.3 Configuring Flash Movie to display in new browser window

Determine the dimensions of the browser window in which your Flash movie will appear. Select full screen, predetermined size or customize the size for your browser window. Set a buffer duration (in seconds) before the movie begins to play.

Choose whether the slide will automatically advance to the next slide when the movie finishes, or if the user must click on the next button.

![Insert Flash Movie](Image)

Finally, click finish to insert your flash movie into the presentation.

![Insert Flash Movie](Image)

A small icon will be inserted on the bottom right-hand corner of the slide. You can position this icon anywhere on the slide. The icon is for your reference only to indicate that a Flash movie has been inserted but it will not appear when the presentation is published. You will be able to view your Flash movie when your presentation is published.
4.4.1.11 Inserting Web Objects

Web Objects can be used for inserting existing Web pages into your presentation. You can integrate your company’s intranet, or incorporate a Web page that contains video, animation, assessments, or any other content relevant to your presentation. You can also insert an entire pre-existing Web site into your presentation.

Select Insert Web Object from the Articulate Menu and the Web Object Wizard will be displayed.

Web Objects can be displayed in two different ways:

- In Articulate Player: This will insert your Web Object directly in your slide.

- In a New Browser Window: A new browser window will be opened independently from your slide.

You have to enter the address (URL) of your Web Object. If the Web site is in your computer, you have to select the folder and make sure that contains an index.htm or an index.html file.
Determine the dimensions of the browser window in which your Web Object will appear. Select full screen, predetermined size or customize the size for your browser window. Set a buffer duration (in seconds) before the Web Object begins to play.

Choose whether the slide will automatically advance to the next slide when the Web Object finishes, or if the user must click on the next button.
• **Settings in New Browser Window**

These settings are useful in limiting what actions a user can perform within the Web Object. The default is to allow the user to resize the window and to scroll around. The user can view the entire content of the Web Object, while restricting the user's ability to surf other Web pages that may not be relevant to the presentation. The browser window settings from which you can choose are identical to those found in Internet Explorer.

![Web Object Wizard](image)

You can only insert a Web Object per slide and it can be viewed after you have published your presentation.

Popup blocking software can cause problems when viewing presentations that contain Web objects configured to appear in a new browser window. If using popup blocking software, it is recommended that the domain from which the presentation is being launched be added as a safe domain so no functionality is lost.
Finally, click finish to insert your web object into the presentation.

4.4.1.12 Attachment

Select Attachments from the Articulate Menu and the dialogue box will be displayed.

For each attachment you have to insert the title, type and path.
4.4.1.13 Player Template Builder

Almost every element of the Articulate Player can be customized. With so many customization options, it is useful to have a way to save and quickly apply pre-configured player options. This can be done with the Player Template Builder.

The Player Template Builder is a simple tool for creating and editing Templates (pre-configured player options) that customize the Articulate Player in a quickly and convenient way.

Select Player Template Builder from the Articulate Menu and the Player Templates Builder will be displayed.
Master Templates

Articulate Presenter comes with four pre-configured Master Templates:

- Corporate Communications
- ELearning Course (Single-level)
- ELearning Course (Multi-level)
- Tradeshow Loop

You can create, save or delete templates in the drop-down menu and preview the different configurations done.

4.4.1.13.1 Layout

**View mode:** Select the format in which the slides will appear to the viewer. You can choose among standard view, no sidebar view (sidebar is not visible), or slide only view (the only item visible is the PowerPoint slide). You can also set a starting view for Articulate Player.

**Panel:** Display/hide logo panel, presenter panel and navigation panel.

**Navigation Tabs:** Display/Hide outline, thumbnails, notes and search tab and set order of tabs using up/down arrow. You can also set a starting tab for Articulate Player.

**Toolbar menu:** Display/Hide the tabs to access the attachments, to allow bookmarks, email your presentation and/or exit link.

**Player Controls:** Display/Hide the volume, navigation and seekbar controls. Decide also whether or not users can navigate using the seekbar.

**Slide Titles:** Edit timing for long slide titles and display/hide the slide number.
4.4.1.13.2 Navigation

Use the Navigation section of the Player Template Builder to configure options for user navigation within the Articulate Player.

*Navigation Restrictions*: Select if user can view slides in any order, view only current and previous slides or cannot change slides.

*Level Expansion Settings*: Select expand behaviour and expand restrictions to allow user access to the slides at different levels.

*Miscellaneous*: Select other settings such as prompt to resume on presentation restart, automatically scroll navigation to keep up with presentation or enable keyboard shortcuts.
4.4.1.13.3 Text Labels

Use the Text Labels option of the Player Template Builder to custom the text for every element of the Articulate Player you want to display.

4.4.1.13.4 Colours

Use the Colours section of the Player Template Builder to modify the colour of a particular
template.

**Edit Color Schemes:** Select this option to load the Colorizer that will allow you to customize the color of your Player by choosing from a set of some predefined color schemes or creating your own color schemes.

4.4.1.13.5 Other

Use the Other section of the Player Template Builder to configure additional player template options.

**Other:** Select other settings such as whether the duration of the presentation should be
displayed; if the presentation should automatically start over from the beginning after the last slide is completed; if the presenter notes should appear when launching, as a tab on the lower right-hand corner or remain hidden.

**Browser Window Settings:** Select the desired browser and presentation size and select if you want to launch the presentation in a new window via launch page. When selecting launch page in a new window you can decide if displaying browser controls and if the user can resize the browser containing.

Select **Preview** to launch the Articulate Player and pre-visualize the options that you previously customized with the Player Template Builder before creating your presentation.

**4.4.1.14 To publish your presentation**

Select **Publish** from the Articulate Menu and the Publish Window will be displayed.
4.4.1.14.1 Publishing for Web delivery

Select this option if you want your presentation to be published locally or if you are going to upload it onto a Web server on the Internet or an Intranet. Also select this option if you want to FTP your published presentation directly to a server.

*Publish Location:* Publish your presentation as a local folder/network where you have to specify the path of the folder or publishing it to a FTP site where you have to put the DNS/IP address, port, username, password and the folder/directory name.

*Properties:* Determine the title of your presentation and choose a player template, logo and presenter.

*Output Options:* Check the *zip box* to compress your presentation into a zip package and check the *Email box* to attach the zip file to a new email.
4.4.1.14.2 Publish to Articulate Online

Publish content directly into your Articulate Online Account.

**Note:** You need to install Articulate Online.

*Properties:* Determine the title of your presentation and the description that will appear along with the presentation in your articulate online account. Choose a player template, logo and presenter if desired. Select how your course’s status will be tracked and deemed with *Reporting* and *Tracking* options.

*Account Information:* You must already have an articulate online account. Insert the account URL, the administrator e-mail address/login and password.
**Reporting:** Select the reporting status Passed/Incomplete, Passed/Failed, Completed/Incomplete and Completed/Failed.

**Tracking:** Select if the user must view a set of slides or successfully completed a Quiz / choices Learning Game before completing the course.

Once you have published your presentation, Articulate Presenter will automatically upload your eLearning course or presentation to your account in Articulate Online.

When the upload has been completed, you will have the option to launch your Web browser to view or manage the content of your presentation in your Articulate Online account.
4.4.1.14.3 Publish for LMS

Select this option if you plan to upload your presentation or eLearning course to a SCORM- or AICC-compliant Learning Management System.

Publish Location: Publish your presentation as a local folder/network where you have to specify the path of the folder or publishing it to a FTP site where you have to put the DNS/IP address, port, username, password and the folder/directory name.

Properties: Determine the title of your presentation and choose a player template, logo, presenter and the communication standard supported by LMS.

Output Options: Check the zip box to compress your presentation into a zip package and check the Email box to send the file by email. Select both options if you want to send the zipped file by Email.

Reporting: Fill in the LMS Course Information Title and Identifier fields. Select also the LMS Reporting status from the drop-drown list. For AICC standards you also have to incluye the Filename (URL) which must be set in advance to the URL of the server from which you will be serving your presentation.
**Tracking:** Select if the user must view a set of slides or successfully completed a Quiz / choices Learning Game before completing the course.

---

**4.4.1.14.4 Publish for CD**

Select this option if you will be distributing your presentation via CD-ROM.

*Publish Location:* Type the path to the folder/network where you want to publish your presentation.
Properties: Determine the title of your presentation and choose a player template, logo and presenter.

Output Options: Check the zip box to compress your presentation into a zip package and check create autorun files box to play automatically your presentation when stored in a CD.

4.4.1.14.5 Publish to Word

Select this option to convert your presentation to Microsoft Word format as a Storyboard or Presenter Notes.

Publish Location: Type the path to the folder/network where you want to publish your presentation.

Properties: Determine the title of your presentation, the presenter and choose and select the output type depending on how much information you require. Storyboard include information of presentation data, presenter data, slide data, slide thumbnails, slide notes, interactions questions and answers, web object information and inserted flash movie information. Presenter Notes exports the presenter notes only.

Output Options: Check the zip box to compress your presentation into a zip package and check the Email box to send the file by email. Select both options if you want to send the zipped file by Email.
4.4.1.14.6 Publish to Project Files

Select this option to publish and archive your source files (PowerPoint file, associated, audio, images. etc.).

Publish Location: Publish your presentation as a local folder/network where you have to specify the path of the folder or publishing it to a FTP site where you have to put the DNS/IP address, port, username, password and the folder/directory name.

Properties: Determine the title of your presentation

Output Options: The published presentation will be created as a Zip package by default. To send the zipped presentation, check the Email box. If you would like to include your source (uncompressed) audio files in your project files, check the Include .WAV files box.
4.4.1.15 View Presentation

Select this option if you want to preview your presentation in Articulate Player.

Select View Presentation from the Articulate Menu.

If you have not yet published your presentation, the following message will appear:
If your presentation has been previously published, you will receive the following message:

![Articulate Presenter]

This viewing will not reflect any changes made to the PowerPoint presentation since the last publish. To view with all changes, click 'Publish'.

You can also view your presentation at any time by navigating to the output location and double-clicking `player.html` or `launcher.html`. 
4.4.2 TURBODEMO [16]

TurboDemo is a capture Screenshots program which allow reproducing actions such as the movement of a mouse cursor and to record audio at the same time that you are capturing using different effects. The video obtained can be compiled in different formats and published by different ways compatible with all current Internet formats.

Turbodemo is easy to use for capturing the activity in your screen and creates interactive demos and tutorials, software simulations and films in few minutes in the following formats:

- Flash demos/tutorials
- Java/HTML demos/tutorials
- Executable files
- EXE - Standalone Player
- GIF files
- Microsoft Word export
- PDF documents
- AVI files and
- ASF - Windows Media Player format
- Export to Word, Excel, etc.

To create a demo or tutorial you only need to follow three simple steps:

1. Capturing: screen shots of a software application or any onscreen activity.
2. Editing: adding animation, text, voice-over and interactive features.
3. Publishing: generating a finished file for the Web or CD.

The main reasons to use TurboDemo are:

- Easy to use.

Create your demo in few minutes with a user-friendly interface.

- Extremely small file size.

The generated demos are optimized and compressed to enable rapid loading.
- No Plug-Ins required.

The viewer does not have to download a plug-in in order to view the demonstration. The generated Demos are independent of the Operating System (Windows, MAC, UNIX...) used.

- Interaction with the viewer.

Add descriptions, notes, objects and actions to personalize your Demo or Tutorial.

Menu items

- **File menu** is used to close and save projects and demonstrations.
- **Edit menu** is used to copy, paste, cut or delete objects.
- **Slide menu** is used to add objects to the current slide; multiple objects can be gathered in a group to enhance.
- **Project menu** is used to add slides to your project after it has been captured and stored.

4.4.2.1 Capturing

Select **New Project** from the File menu.

The first step is to specify the windows size to start capturing. You can do this manually or using a preseted size. You can also change Hot-Keys to capture (predefined keys to execute an option).
The next step is to select the screenshot capture options by checking the different predetermined options that you want to use in your project.

There are several ways to capture or record a screenshot; using the right- or left-click of your mouse or using a hotkey. Additionally, TurboDemo may be set to automatically capture at the rate of an adjustable amount of screenshots per second. By using a hotkey you can toggle between screenshot mode and thumbnail mode to monitor the screenshots you have taken.
Choose the appropriate resolution for capturing; TurboDemo will show you a rectangle of this size on the screen. You can also adjust the size of the rectangle by clicking on the dots on the red frame and moving them.
Adjust the red frame to the application that you want to capture, fit easily your application into this red rectangle by using the hot-keys **CTRL+SHIFT+P** or **CTRL+SHIFT+R**; with each click of your mouse in the red rectangle area TurboDemo will capture the current screen. Alternatively you can define a key to do this by default is the **Pause Key**.

When finished capturing, you can return by clicking on the TurboDemo icon in the System Tray. When this icon is hidden from view, press the **Print Key** to finish capturing.

After finish capturing you can edit, generate or publish your Demo/Tutorial.

- **Automatic Capture Screenshots**

You can capture screenshots automatically at preset time intervals. This automatic interval can be toggled with the key sequence **CTRL+SHIFT+T**.

- **Capture Screen and Audio**

To capture screenshots and audio at the same time, you should choose the appropriate option in the **Screenshot Wizard** before you start the capture session. The audio gets cut when you capture a screenshot, which means that you need to record the audio first and then take your screenshot, in order to avoid hops in the audio playback.
4.4.2.2 Editing

When you are done capturing screenshots, you will start in Thumbnail mode, where you can see your slides, add, move and remove them. Selecting one slide you switch to single slide mode where you can add text, animated objects, photos, images, interactivity, links to the web, and sound.

4.4.2.2.1 Thumbnail Mode / Slide View Mode

Thumbnail mode is the main view of Turbodemo, which provides an instant overview of your project and appears immediately after you finish the screenshot session.

In this mode you can cut, paste, copy and delete slides, insert slide actions and add sound. You can also easily open other projects and copy slides from them to your current project.

The main options you can access quickly from the Thumbnail view are the following:

View: Select a slide to switch to Single Slide Mode or play a demo of your slide to have a preview of your project.

Slide Tasks: Here you have the principal tasks to work with the slides, insert sound, effects and colours to your slides.

Export Slides as: Select a format to export your project.
4.4.2.1.1 Project Options

Select **Options** from the Project menu and configure the settings of your project.

**Timing:**

- **Minimum reading time:** Set the shortest time a slide is shown. This option is useful if you want to capture screenshots automatically.
- **Character reading time:** Set the time that is added to a slide when notes or bubbles are added.
- **Mouse pointer speed:** Adjust the speed of the mouse pointer movement.

**Miscellaneous:**

- **Animation:** choose if notes and balloons will be animated or not.
- **Show action description of object:** select if the assigned object actions will be displayed in the slides.

**Subject:**

- **Title & Comment:** give a title to your project and add a comment to it.
4.4.2.2.1.2 Insert Sound

Add sound or tone with voice and background music. Select *Insert Sound* from the *Slides Tasks* panel or by clicking the *speaker* icon on the slide.

To start recording press the *red button* and to stop recording press the *square black button*.

Audio can also be imported. Navigate in the sound recorded, export audio to a .WAV file or delete it. If you add sound or narration to the slide you can choose add sound to only one slide or to several slides.
Change and edit your recorded or inserted audio, adding silence, comments and adjust volume with the audio editor. To access the audio editor select the Advanced Mode option.

4.4.2.2.1.3 Add an image

Add your company logo or a simple image.

Select Add Image(s) as a Screenshot or Insert Image(s) as a Screenshot from the Project menu.
By inserting images the selected picture will be positioned between the other slides but if you add it will be moved directly after the last slide.

You can also add or insert new Screenshots images and Blank Slides to your current project and change the slide color if desired by selecting the appropriate option from the Slides Tasks panel.

4.4.2.2.1.4 Slide Transitions

Assign transitions to the slide selecting Slide Effects from the Slide Tasks panel. Choose a predetermined effect and the colour for when each slide appears and disappears. You can also preview your selected effect.
4.4.2.2.1.5 Adding Objects and actions to a slide

This is also a type of interactivity option that allows the user to create customized areas or regions and assign them to an action which gives the ability for the end-user to jump and move from one slide to another in the project or going to an URL.
4.4.2.2.2 Single Slide Mode

To edit slides **double-click** on any slide in the *thumbnail view*

Navigate to other slides by clicking the top bar arrows on the *Player Controls*.

The main options you can access quickly from the *Single Slide Mode* view are the following:

**View:** Select this option to return to *thumbnail view*.

**Add to Slide:** Here you have the principal interaction objects you can add to each slide such as *notes, balloons, rollovers, quizzes*...

**Slide Tasks:** Here you have the principal tasks to work with the slides, insert sound, effects and colours to your slides.

**Player controls:** select this option to navigate to other slides and to play the selected slide.
4.4.2.2.1 Description Notes

Add text objects via Text Notes, Balloons, Text Objects and Rollosers selecting from the Add to Slide menu.
To edit the text object double-click on the object square. Select the font and style in the text box and the appearance of the object selecting the appropriate skin settings.

4.4.2.2.2 Animations

Add animations as pointers, elastic bands, Shockwave Flash files and typing simulation to draw the attention of the viewer to a particular part of your presentation. Select these options from the Add to Slide menu.
4.4.2.2.3 Interactive functions

Add interactive functions as **click area**, **text area**, **pause button** and **quizzes**. For the **click area** and the **text area** a message of success or error will be displayed depending on the user's actions. With the **pause button** the user can stop in the selected slide. Select these options from the **Add to Slide** menu.

You can only add one interactive function per slide.
4.4.2.2.4 Question and Answer (Quiz)

The question and answer quiz is very suitable for the creation of multiple choice tasks for your eLearning demonstrations. You may write down your questions directly or use preset questions in the form of images.

You can decide whether only one answer is correct or whether several correct answers are possible.

Depending on the answer the success or error message will be displayed. To the success message and the error message can be assigned an action option. This means that after showing the message an action or event will occur.

The quiz object can have multiple individual error messages.
4.4.2.3 Publishing

Publishing or playing a demo.

Select Generate Demo / Publish Demo from the File menu and select the appropriate format for your Demo or Tutorial:
The first step to publish in all the formats is to select a folder where will be saved all the files that Turbodemo will generate.

4.4.2.3.1 Generate a FLASH (SWF), EXE (Standalone) or JAVA (Applet)

- Settings

Select the color mode, tutorial title, miscellaneous options, output language, version information and choose between the following Navigation Panels and Skins for Flash and Exe formats:

**No Control Panel**: Run your Tutorial without using a navigation panel or menu.

**Navigation Panel**: A navigation control panel will be added to the bottom of your Tutorial including play control buttons.

**Hidden Panel**: A hidden panel is displayed on the top right hand corner of your Tutorial. The navigation panel is hidden as menu and is automatically shown when the end-user indicates it with the mouse.

![Generate a FLASH Animation (SWF)...](image)

- Statistics

You can generate demonstrations or learning software that can be included into Learning Management Systems in SCORM standard. These Demo or Tutorial files can also be compressed automatically to one single file, if the LMS requires it.

Select if you want the statistics to be shown at the end of the demo and the pass conditions that will allow the user to access the next level.
4.4.2.3.2 GIF-Animation and Windows Media Player (ASF)

Select if you want to export your Tutorial with slides transitions and / or export sound in ASF format.
4.4.2.3.3 Word Document

Select the appearance of your final word document and the slides and objects that you want to export. You can also import a template, introduction and conclusion from another word file.

![Image of the export to Word interface]

4.4.2.3.4 PDF Document

Select the appearance of your final PDF document and preview it before exporting.

![Image of the export to PDF interface]
4.4.2.3.5 Images (BMP, GIF, JPEG)

Select the image format for your slides, their size and which of the slides and objects you want to export.
4.4.2.3.6 Resize the Project

After you have completed a Demo or Tutorial you can alter the resolution size of your project.

Select Resize in File menu and the Wizard Dialog will be displayed, the original width and height is displayed at 100%. After finish resizing, a new project with the resolution size selected will be saved automatically.

![Resize Wizard]

If you wish to put your Demo or Tutorial on your homepage then you have to upload the Demo or Tutorial files to your web-server. If you wish to put your Demo or Tutorial on a CD-ROM or other media, you have to copy the files into a directory or folder.